Upgrade Guide
Content

1 About this guide ................................................................. 4

2 Upgrade SAP Information Steward ....................................................... 5
   2.1 Upgrade an existing environment .................................................. 6
       Preparation .............................................................................. 6
       Upgrading your existing environment ........................................... 6
       Re-enable SSL ......................................................................... 7
       Upgrading metadata collection from BusinessObjects Enterprise 3.x ........................................ 8
       Upgrade considerations for Match Review ..................................... 8
       Upgrade considerations for Data Insight views that contain SAP tables ........................................ 9
   2.2 Verify upgrade success ................................................................. 9
       Checking the Information Steward version in the CMC ..................... 10
   2.3 Data Cleanse upgrade ................................................................. 10
       Content upgrade log file ............................................................ 11

3 Migrate to a new environment ............................................................ 12
   3.1 Migrating Information Steward to a new environment ....................... 12
   3.2 Objects supported for migration ................................................... 13
   3.3 Migrating CMS content using Promotion Management ..................... 15

4 Information Steward behavior changes .................................................. 18
   4.1 Changes in version 4.2 SP8 (14.2.8.0) ........................................... 18
       Data Insight (14.2.7.2 and 14.2.8.0) ........................................... 18
       Metadata Management (14.2.8.2 and 14.2.9.0) ............................... 19
   4.2 Changes in version 4.2 SP4 (14.2.4.0) ........................................... 20
       Cleansing Package Builder (14.2.4.0) ........................................... 20
   4.3 Changes in version 4.2 SP3 (14.2.3.0) ........................................... 20
       Cleansing Package Builder 4.2 SP3 ............................................. 21
       Data Insight 4.2 SP3 ............................................................... 21
   4.4 Changes in version 4.2 SP2 (14.2.2.0) ........................................... 21
       Metapedia 4.2 SP2 ............................................................... 22
   4.5 Changes in version 4.2 SP1 (14.2.1.0) ........................................... 22
       Data Insight 4.2 SP1 ............................................................... 23
       Metadata Management 4.2 SP1 ................................................. 23
   4.6 Changes in version 4.2 (14.2.0.0) ............................................... 24
       Cleansing Package Builder 4.2 ................................................... 24
       Connection changes in 4.2 ...................................................... 26
       Match Review changes in 4.2 .................................................... 28
Data Insight changes in 4.2 ..................................................... 28

4.7 Changes in version 4.1 SP1 (14.1.1.0) ................................................... 29
Data Insight 4.1 SP1 ............................................................... 29
Metadata Management 4.1 SP1 .................................................. 30
Metapedia 4.1 SP1 ................................................................. 31

4.8 Changes in version 4.1 (14.1.0.0) .................................................. 32
Changes in locations for user interface options ..................................... 32
Metadata Management 4.1 ....................................................... 33
Metapedia 4.1 ................................................................. 34
Cleansing Package Builder 4.1 ................................................... 34

5 SAP information resources ....................................................... 41
1 About this guide

Use this guide to help you with upgrading to a new SAP Information Steward version. Refer to the latest Release Notes for version information. Also use this guide to review the changes in the latest version and past versions of Information Steward.

This guide contains the following upgrade topics:

- Upgrade from previous versions of Information Steward
- Behavior changes associated with each version of Information Steward
- Upgrade metadata collection from SAP BusinessObjects Enterprise 3.x machine
2 Upgrade SAP Information Steward

You can upgrade to SAP Information Steward version 4.2 Support Package 8 (4.2.8.0) in any of the following ways based on your system setup.

Table 1:

<table>
<thead>
<tr>
<th>Upgrade method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Fresh install</strong></td>
<td>First time installation of Data Services (DS) and Information Steward (IS). No previously configured objects. Use when you are new to the product or using the product in a new environment.</td>
</tr>
<tr>
<td></td>
<td>There are a few options for the fresh install based on whether you use SAP BusinessObjects Business Intelligence (BI) or SAP BusinessObjects Information platform services (IPS).</td>
</tr>
<tr>
<td></td>
<td>● BI 4.1 SP8 or 4.2 SP2/SP3 full + DS 4.2 SP8 + IS 4.2 SP8</td>
</tr>
<tr>
<td></td>
<td>● IPS 4.1 SP8 or 4.2 SP2/SP3 full + DS 4.2 SP8 + IS 4.2 SP8</td>
</tr>
<tr>
<td><strong>Upgrade install with uninstall/reinstall</strong></td>
<td>Uninstall previous versions of Data Services and Information Steward before installing the most current version. Reuse the configurations from the previous installation. Use this option when upgrading from version 3.x to 4.2 SP8.</td>
</tr>
<tr>
<td><strong>Upgrade install with update capability</strong></td>
<td>Install the current version of Data Services and Information Steward without uninstalling previous versions. Automatically reuse configurations from the previous installation.</td>
</tr>
<tr>
<td></td>
<td>There are two options for the upgrade install based on whether your previous installation was Information Steward 4.0 or Information Steward 4.1.</td>
</tr>
<tr>
<td></td>
<td>● Upgrading from version 4.0: BI/IPS 4.0 SP4 + DS 4.0 SP3 + IS 4.0 SP3 + BI/IPS 4.1 SP8 or 4.2 SP2/SP3 + DS 4.2 SP8 + IS 4.2 SP8</td>
</tr>
<tr>
<td></td>
<td>● Upgrading from version 4.1: BI/IPS 4.1 SP4 + DS 4.1 SP2 + IS 4.1 SP2 + BI/IPS 4.1 SP8 or 4.2 SP2/SP3 + DS 4.2 SP8 + IS 4.2 SP8</td>
</tr>
</tbody>
</table>

<i>Note</i>

If you are updating your deployment from BI/IPS 4.0 or 4.1 to 4.2 using the update installation program, and if you use the bundled IBM DB2 Workgroup Edition (UNIX) or Microsoft SQL Server 2008 Express (Windows) database server, these database servers are preserved. You can continue to use these bundled database servers for SAP Data Services repository.

<i>Note</i>

The release of Information Steward 4.2 SP1 included the Data Cleansing Advisor feature. SAP BusinessObjects Business Intelligence (BI) or SAP BusinessObjects Information platform services (IPS) must be upgraded to version 4.0 SP5 patch 4 or newer before you can access Data Cleansing Advisor.

For additional information about installing the software, see the Master Guide and the Install Guide.
Related Information

Preparation [page 6]
Verify upgrade success [page 9]

2.1 Upgrade an existing environment

Run the Information Steward setup file to begin the upgrade process. The installer detects that a version of Information Steward is already installed and upgrades the features that are already installed to the new version.

**Note**

In a distributed deployment where the primary installation is on a Linux computer and an expanded installation is on one or more Windows computers, you must upgrade the Linux computer before you upgrade the Windows computers.

For additional upgrade scenarios, see the SAP Data Services and SAP Information Steward Master Guide.

For information about installing new or additional features, see the Installation Guide.

2.1.1 Preparation

To prepare for upgrading your current installation of SAP Information Steward to a newer version or service pack, perform the following tasks:

- Back up your Information Steward repository using the backup utility provided by your database vendor. Make sure that your database backup allows you to restore all of the repository tables and data.
- Export your user-created content such as projects or their contents (tables, rules, rule binding, scorecards, and so on), custom attributes, Metapedia terms, and categories.
- Upgrade the SAP Business Intelligence (BI) platform or Information platform services (IPS).
- Upgrade the BI platform client to the same version as the BI server if a BI platform client is installed on the machine where Information Steward is installed. Likewise, if you use an IPS client, upgrade it to the same version as the IPS server if an IPS client is installed on the machine where Information Steward is installed.
- Upgrade SAP Data Services to a version that is compatible with the version of Information Steward.
- Update the Data Services-supplied SAP transport files and SAP authorizations on the SAP server. For more information, see the SAP Data Services Supplement for SAP.
- Disable the Secure Socket Layer (SSL) protocol on the Central Management server (CMS) if applicable. The Information Steward installer does not support the SSL protocol during the installation process.

2.1.2 Upgrading your existing environment

Before installing Information Steward 4.2 SP8, you must install Data Services 4.2 SP8.
The following steps apply when upgrading to the 4.2 SP8 version of Information Steward.

1. Launch the setup program for the new version of Information Steward as follows:
   ○ On Windows, double-click `setup.exe`. In the setup program, set the installation location to the same location as your current installation of
   ○ On Linux, type `./setup.sh`.

2. Information Steward.
   The installer detects that a version of Information Steward is already installed and updates existing features. When applicable, choose to install new features and new optional objects.

3. Enter administrator-level connection information for your Central Management Server (CMS).
   When you are upgrading Information Steward, the CMS

4. If you are upgrading a repository of database type DB2 or connection automatically retrieves all connection data except the password. When prompted, enter the repository password. SAP HANA the `Data Source Name` or `Database Connection Name` parameter still appears. You cannot change to a server name connection.

5. If you are upgrading a repository of database type Oracle version 9, the `TNS Name` and `Database Connection Name` in the setup program, set the parameters still appear. In this situation, you must upgrade the Oracle database to version 10 or higher because the older versions are no longer supported. You can change the parameters `connection automaticallyMachine Name`, `SID`, `Port Number`, `Database Connection Name`, and so forth.

   For more information about backing up your repository, see the Administrator Guide.

6. If you want to be able to use Information Steward’s Data Cleansing Advisor feature, enable the Data Cleansing Advisor service as follows:
   a. In the Central Management Console, choose `Servers > Service Categories > Core Services`
   b. Stop the `EIMAdaptiveProcessingServer`.
   c. Right-click `EIMAdaptiveProcessingServer` and choose `Select Services`.
   d. Move `Data Cleansing Advisor Service` from the list of available services to the list of services for `EIMAdaptiveProcessingServer`.

7. If you have a distributed environment, upgrade each machine that hosts Information Steward components to the new version of Information Steward. The order in which you upgrade the machines does not matter.

Related Information

Verify upgrade success [page 9]
Migrate to a new environment [page 12]

2.1.3 Re-enable SSL

If you use the SSL protocol on the CMS or a web application server and you disabled it prior to installing Information Steward, you must re-enable it before you use the upgraded Information Steward application.
2.1.4 Upgrading metadata collection from BusinessObjects Enterprise 3.x

You can upgrade the metadata collection in an SAP BusinessObjects Enterprise XI 3.x machine to the newest version of Information Steward.

The SAP BusinessObjects Enterprise Metadata Integrator in the new version of Information Steward uses a remote job server to collect metadata from an SAP BusinessObjects Enterprise XI 3.x machine.

Before you upgrade the remote job server in SAP BusinessObjects Enterprise XI 3.x:

- Upgrade your primary installation of Information Steward.
- Disable the SSL protocol (if applicable) in the CMS. The Information Steward installer does not support the SSL protocol during the installation process.

To upgrade the remote job server installed on an SAP BusinessObjects Enterprise XI 3.x machine:

1. On the computer where SAP BusinessObjects Enterprise XI 3.x is installed, follow a standard installation for Information Steward until you come to the BusinessObjects Enterprise Server Login window.
2. Specify the login information for the Central Management Server (CMS) that you will use to configure and schedule integrator source runs and click Next. The installation wizard detects that a previous version of the Information Steward Remote Job Server is installed and automatically upgrades it.

If you disabled the SSL protocol on the CMS, re-enable it after you have upgraded Information Steward.

For more information about upgrading metadata from BusinessObjects Enterprise 3.x, see the SAP Information Platform Services Administrator Guide and the SAP Business Intelligence Platform Administrator Guide

2.1.5 Upgrade considerations for Match Review

You can upgrade your match review configurations to this version of Information Steward. Before you run the installation wizard, perform the following tasks:

- Ensure existing match review configurations do not use the same database connection and input table name. If match review tasks with status In Progress exist and different match review configurations reference an input table with the same name, the match reviewer can only work on the input table that was worked on first.
- Finish all match review tasks with status In Progress. If tasks with status In Progress exist when the installation wizard upgrades the match review configurations, the reviewed data will also be migrated.
2.1.6 Upgrade considerations for Data Insight views that contain SAP tables

The data transfer method for reading SAP tables contained in Data Insight views is specified when your Administrator defines the connection in the Central Management Console (CMC). The default data transfer method is different for each Information Steward release, as the following table shows:

Table 2:

<table>
<thead>
<tr>
<th>Information Steward release version</th>
<th>Default Data Transfer Method</th>
<th>Additional information</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.2 SP1</td>
<td>ABAP</td>
<td>You can also specify RFC (Remote Function Call), Shared directory, or FTP.</td>
</tr>
<tr>
<td>4.2 SP2</td>
<td>RFC</td>
<td>ABAP is disabled for all views.</td>
</tr>
<tr>
<td>4.2 SP3</td>
<td>RFC</td>
<td>You can now enable ABAP for a Data Insight view with the new Data Transfer Method option in the View Editor.</td>
</tr>
</tbody>
</table>

2.2 Verify upgrade success

After upgrading your existing environment to a new version of SAP Information Steward, verify that the servers are running and the version number has been updated.

Table 3:

<table>
<thead>
<tr>
<th>Verify</th>
<th>Steps</th>
</tr>
</thead>
</table>
| The EIMAdaptiveProcessing-Server and ISJobServer in the Central Management Console (CMC) should be running and enabled. If they are not enabled, restart and enable them. | 1. Log on to the CMC.  
2. Select Servers from the Organize drop list on the CMC Home page.  
3. Expand Service Categories in the file tree at left.  
4. Click Enterprise Information Management Services listed under the Service Categories folder.  
5. Scan the servers listed at right to make sure the State column contains “Running” and the Enabled column contains “Enabled.”  
If the Enterprise Information Management Server is not running or enabled:  
1. Select the server name from the list and click Actions.  
2. Select Start Server or Enable Server as applicable. |
<table>
<thead>
<tr>
<th>Verify</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>The SAP Information Steward software installed on your system should reflect the newest version number.</td>
<td>Choose one of the following methods:</td>
</tr>
<tr>
<td></td>
<td>• View a list of installed programs from your operating system, and verify SAP Information Steward is the version that you just installed.</td>
</tr>
<tr>
<td></td>
<td>○ In Windows, open the Control Panel and view the list of installed programs.</td>
</tr>
<tr>
<td></td>
<td>○ In Linux, change to the directory where Information Steward is installed, and run the command ./modifyOrRemoveProducts.sh.</td>
</tr>
<tr>
<td></td>
<td>• Check the version in Information Steward by choosing Help &gt; About.</td>
</tr>
</tbody>
</table>

**Note**

If the version in the About box is not the latest version, your web deployment may have failed. Use WDeploy to redeploy the Information Steward web application.

If the installation process completed with a warning message that the Information Steward repository upgrade failed, you must manually upgrade the repository with the ISRepositoryUtility command-line utility. For details, see the Administrator Guide.

### 2.2.1 Checking the Information Steward version in the CMC

To check the installed version of Information Steward in the Central Management Console (CMC):

1. Log on to the CMC.
2. Select Servers from the CMC Home page drop list.
3. Click Servers List.
4. Right-click an Information Steward server, for example, ISJobServer, and select Metrics.
   - The version is displayed in the list of Common Server Metrics in the Version row.
5. Click OK to close the window.

### 2.3 Data Cleanse upgrade

For new versions of Information Steward, when there are changes to the Cleansing Package Builder mode, there are two possible upgrade options.

- Schema upgrade: applies to published and private cleansing packages.
- Content upgrade: applies changes to the Person_Firm cleansing package. Custom cleansing packages cannot be used in the content upgrade process.

Check the Information Steward behavior changes [page 18] section for the current version of Information Steward to see what upgrade methods are required for upgrading Cleansing Package Builder to the latest version.
Schema upgrade

A schema upgrade applies to published cleansing packages. The schema upgrade affects classifications and the underlying structure of the cleansing package necessary for use with the Data Cleanse transform.

Upgrading the schema does not automatically upgrade the content. Additionally, if you want to upgrade the Person_Firm cleansing packages, see the Content Upgrade section.

To upgrade the published cleansing package schema, open, modify, and then republish the cleansing package. Private cleansing package schemas are automatically updated when they are edited and during merge or content upgrade process.

Content upgrade

A content upgrade applies only to Person_Firm cleansing packages. The term content refers to the data of the cleansing package: standard forms, variations, reference data, and rules. Content upgrade does not apply to custom cleansing packages.

2.3.1 Content upgrade log file

The software writes all errors and warnings for a content upgrade to a log file. Administrators can find the log file in the platform's logging folder.

The log file name includes the name of the service where Cleansing Package Builder's Publishing Service is installed. By default, the location is in the EIM Adaptive Processing Server. Use the date and time listed in the file explorer to help determine the correct log file.

Example

In Windows, find the log file in <%BOE_Install%>\SAP BusinessObjects Enterprise XI <current_version>\logging

Example

Log file name: aps_<system_name>.EIMAdaptiveProcessingServer_trace.<number>.glf
3  Migrate to a new environment

You may want to migrate Information Steward to expand to a distributed environment, to move from a test environment to a production environment, or to install Information Steward on a separate Information platform services (IPS).

Note
We recommend installing Information Steward on a separate IPS. You should upgrade to the most recent Information Steward version before you migrate to a new environment.

3.1  Migrating Information Steward to a new environment

The following topics describe how to migrate your existing Data Services and Information Steward deployment in a Business Intelligence (BI) platform 4.0 landscape to a private Information platform services (IPS) landscape on new hardware.

Before migrating to a new environment, install SAP BI Platform or SAP Information platform services (IPS) version 4.1 SP8 or 4.2 SP2/SP3 (or its higher compatible patches). We recommend installing IPS. Then install Data Services 4.2 SP8 and Information Steward 4.2 SP8.

Because this scenario involves hardware migration, you need a new server machine on which to install IPS, Data Services and Information Steward. For information about upgrading Data Services, see the SAP Data Services Upgrade Guide.

The following steps apply when moving the same version of Information Steward from one computer to another.

Note
See the SAP Data Services and SAP Information Steward Master Guide to read about migrating to a distributed environment.

1. On machine 1, back up your existing Information Steward 4.2 SP8 repository.
2. On machine 2, install SAP BI Platform or SAP Information platform services (IPS) version 4.1 SP8 or 4.2 SP2/SP3 (or its higher compatible patches) so that a new Central Management Server (CMS) repository is created.
3. On machine 2, install SAP Data Services 4.2 SP8.
4. On machine 2, install Information Steward 4.2 SP8. During installation, make the following selections:
   ○ Select the primary installation type.
   ○ Enter the connection information for the CMS on the new IPS.
   ○ Specify the connection information for the Information Steward repository database on machine 1. This repository will be upgraded as part of the installation.
   ○ Choose the upgrade repository option.
5. Move repository objects using either Lifecycle Management (if using BI 4.0) or Promotion Management (if using BI 4.1).

After installation is complete, create a new job server using the Data Services server manager and associate it with the Information Steward repository.

You can promote cleansing packages to the upgraded environment using the Promotion Management tool in the CMC.

You can find more information about many of these steps in the following guides:

Table 4:

<table>
<thead>
<tr>
<th>How to</th>
<th>Resource</th>
</tr>
</thead>
<tbody>
<tr>
<td>● Install Information Steward to a distributive environment</td>
<td>SAP Data Services and SAP Information Steward Master Guide</td>
</tr>
<tr>
<td>● Install Data Services components for Data Insight</td>
<td></td>
</tr>
<tr>
<td>Install Information Steward</td>
<td>SAP Information Steward Installation Guide</td>
</tr>
<tr>
<td>● Create a new repository</td>
<td>SAP Information Steward Administrator Guide</td>
</tr>
<tr>
<td>● Create new job server</td>
<td></td>
</tr>
<tr>
<td>Install SAP IP services</td>
<td>SAP Information Platform Services Administrator Guide</td>
</tr>
<tr>
<td>Install SAP BI platform</td>
<td>SAP Business Intelligence platform Administrator Guide</td>
</tr>
<tr>
<td>Promote a cleansing package using the Promotion Management tool</td>
<td>CMC Help file (<a href="#">Help</a>) or SAP Business Intelligence platform Administrator Guide</td>
</tr>
</tbody>
</table>

Related Information

Objects supported for migration [page 13]
SAP information resources [page 41]

### 3.2 Objects supported for migration

Use the Promotion Management tool in the Central Management Console (CMC) to move Information Steward objects from an existing Information Steward environment to the new Information Steward environment. For instructions see [Migrating CMS content using Promotion Management][page 15].

All the information associated with each object, including user security, is retained. Access more information about the Promotion Management tool in the CMC Help file ([Help](#)) or SAP Business Intelligence platform Administrator Guide.

**Note**

Users who are upgrading from SAP BusinessObjects Enterprise XI 3.1 and SAP Metadata Management 3.1 to BI Platform 4.0.x and Information Steward 4.1 should use the Upgrade Manager utility.

To access the Promotion Management tool:
1. From the CMC Home page, select Promotion Management from the Manage list. The Promotion Jobs tab opens.

2. Select New Job and complete the options as applicable.

3. Click Create. The new job is created, and the Add Objects from the system dialog box opens.

You can move the following objects from the Add Objects from the system dialog box. For each object, select the objects and click Add, or Add & Close.

<table>
<thead>
<tr>
<th>Object</th>
<th>Path in Promotion Management</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profiling connections</td>
<td>• Select Information Steward &gt; Connections from the file tree at left.</td>
</tr>
<tr>
<td>Data Insight projects</td>
<td>• Select Information Steward &gt; Enterprise Profiling Projects from the file tree at left.</td>
</tr>
<tr>
<td>Profiling tasks and rule tasks</td>
<td>1. Select Information Steward &gt; Enterprise Profiling Projects from the file tree at left.</td>
</tr>
<tr>
<td></td>
<td>2. Click Manage Dependencies.</td>
</tr>
<tr>
<td>Metadata Management Integrator Sources</td>
<td>• Select Information Steward &gt; Metadata Management Integrator Sources from the file tree at left.</td>
</tr>
<tr>
<td>Metadata Management Source Groups</td>
<td>• Select Information Steward &gt; Metadata Management Source Groups from the file tree at left.</td>
</tr>
<tr>
<td>User-created utilities and scheduling information for Information Steward utilities</td>
<td>• Select Information Steward &gt; Metadata Management Utilities from the file tree at left.</td>
</tr>
<tr>
<td>Metapedia user security settings</td>
<td>• Select Information Steward &gt; Metadata Management Metapedia from the file tree at left.</td>
</tr>
<tr>
<td>Published cleansing packages</td>
<td>• Select Data Quality &gt; Cleansing Packages &gt; Published from the file tree at left.</td>
</tr>
<tr>
<td>Private cleansing packages</td>
<td>• Select Data Quality &gt; Cleansing Packages &gt; Private from the file tree at left.</td>
</tr>
<tr>
<td>Information Steward security (users and user groups)</td>
<td>1. Select the applicable user type (such as User or User Groups) from the file tree at left.</td>
</tr>
<tr>
<td></td>
<td>2. Choose the applicable user groups.</td>
</tr>
</tbody>
</table>

**Related Information**

Migrating CMS content using Promotion Management [page 15]
### 3.3 Migrating CMS content using Promotion Management

Use the Promotion Management tool in the Central Management Console (CMC) to move objects from an existing Data Services or Information Steward 4.x environment to the latest version's environment.

When you use Promotion Management for migration, all the information associated with the object, including user security, is retained. For complete information about Promotion Management, see the SAP BusinessObjects Business Intelligence platform Administrator Guide or Information platform services Administrator Guide.

1. Login to the CMC on the target server (the machine that has IPS 4.0 SP5, or higher).
2. Under the CMC Home drop-down list, select Promotion Management.
3. Connect to the source system.
   a. Choose Settings > Manage Systems.
   b. Click Add, and then add the connection details for the source server.
   c. Check Mark as Origin, and then click OK.
4. Connect to the destination system.
   a. Click Add, and then add the connection details for the source server.
   b. Click OK, and then Close.
5. Create a job.
   a. Choose New Job, and then enter a name for the migration job.
   b. Select the location where you want to save the job.
   c. In the Source option, select Login to a New CMS.
   d. Select the source system, enter the user name and password, and then click Login.
   e. (Optional) Select a destination system. by selecting Login to a New CMS to place the objects on the target system when the job is promoted, or select Output to LCMBAIR File to export a BAIR file, and then import the file on the destination system.
   f. Click Create.
6. From the Add Objects window, choose one or more objects listed in the table, and then click Add.

The table includes both Data Services and Information Steward objects. Choose the objects that you want to promote.

<table>
<thead>
<tr>
<th>Product</th>
<th>Object</th>
<th>Path in Promotion Management</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Services</td>
<td>Repositories</td>
<td>Data Services &gt; Repositories</td>
</tr>
<tr>
<td>Data Services</td>
<td>RFC Configurations</td>
<td>Data Services &gt; RFC Configurations</td>
</tr>
<tr>
<td>Data Services</td>
<td>Published cleansing packages</td>
<td>Data Quality &gt; Cleansing Packages &gt; Published</td>
</tr>
<tr>
<td>Data Services</td>
<td>Data Services security (users and user groups)</td>
<td>Users or User Groups. For more information see the SAP BusinessObjects Business Intelligence platform Administrator Guide</td>
</tr>
<tr>
<td>Information Steward</td>
<td>Profiling connections</td>
<td>Information Steward &gt; Connections</td>
</tr>
<tr>
<td>Information Steward</td>
<td>Data Insight projects</td>
<td>Information Steward &gt; Enterprise Profiling Projects</td>
</tr>
</tbody>
</table>
Information Steward | Data Review | Information Steward > Data Review
---|---|---
Information Steward | Profiling tasks and rule tasks | 1. Select a project object from Information Steward > Enterprise Profiling Projects
2. Click Manage Dependencies.
3. Select the profiling tasks and rule tasks to upgrade.
4. Click Apply & Close.
Information Steward | Metadata Management Integrator Sources | Information Steward > Metadata Management > Integrator Sources
Information Steward | Metadata Management Source Groups | Information Steward > Metadata Management > Source Groups
Information Steward | User-created utilities and scheduling information for Information Steward utilities | Information Steward > Metadata Management > Utilities
Information Steward | Metapedia user security settings | Metadata Management > Metapedia folder
Information Steward | Published cleansing packages | Data Quality > Cleansing Packages > Published

**Note**
Skip cleansing packages if they were migrated as a part of the Data Services migration.

**Note**
When selecting the repositories to migrate, review the list of existing repositories and carry forward only the valid ones. If there are any obsolete or invalid repositories, deselect those from the promotion job.

**Note**
Promotion jobs can take a long time to complete when there is a large cleansing package. For this reason, you might want to create a separate migration job for cleansing packages. If you have multiple cleansing packages, create several separate migration jobs.

7. After all objects are added, click Close.

**Note**
Objects can be added later with the Add Objects icon.

8. (Optional) Choose Manage Dependencies and select any dependent objects that you would like to migrate.
9. Click Promote.
10. (Optional) Promote security settings by following the sub-steps:
   c. Click Save.
   d. Choose Test Promote.
   e. Click the Test Promote button. Verify that the test promotion is successful.

   **Note**  
   If there are many objects to be promoted, this may take some time to complete.

11. If you created several migration jobs, select them and then click Promote to complete the migration of the CMS content.

   **Note**  
   Depending on the size of the projects and the contents, it might take several minutes to complete the promotion job. If the content is too big, consider breaking the contents into multiple migration jobs.

12. Click History to verify the job status. Click the Refresh icon as necessary until the job is completed.

13. Login to the CMC on the destination system to verify that all objects (repositories, users and user groups, if any) have been migrated.

   **Note**  
   With regard to EIM APS Services configuration, the new Information platform services/Data Services landscape Services configuration parameters are set to default values. If you previously modified any of the Service configuration parameters, log on to the CMC to change the parameters to your custom settings.

   **Note**  
   With regard to Data Services Application settings, the new Information platform services/Data Services landscape application settings are set to default values. If you previously modified any of these settings, log on to the CMC and change the options to your custom settings (CMC Home ➔ Applications ➔ Data Services Application).

See also:
- Data Services and Information Steward Master Guide: Separate Information platform services and BI platform
4 Information Steward behavior changes

This section describes behavior changes associated with the Information Steward product since version 14.1.0.0. Each behavior change is listed under the version number in which the behavior originated.

4.1 Changes in version 4.2 SP8 (14.2.8.0)

The following modules have changes in the Information Steward 4.2 SP8:

- Data Insight

4.1.1 Data Insight (14.2.7.2 and 14.2.8.0)

Upgrade information for Information Steward Data Insight.

Export tasks for external scheduler

This feature is included in Information Steward 4.2 SP7 patch 2 (14.2.7.2) and in 4.2 SP8 (14.2.8.0).

Enhancements to generated execution commands for external scheduling for rule and profile tasks may require you to regenerate existing commands that were generated in Information Steward 4.2 SP7 and earlier.

If you are currently using Information Steward version 4.2 SP7 or earlier, and you upgrade to version 4.2 SP7 Patch 2 or later, you may need to regenerate your existing execution commands if:

- the system name and password have changed
- the task name has changed

If you regenerate existing generated execution commands after you upgrade to Information Steward 4.2 SP7 patch 2 or later, the commands will be different because of enhancements to the feature. Enhancements include:

- Expanded permissions. In addition to Administrators, users with scheduling privileges and the right to track activities can also export tasks to an external scheduler.
- Protected system information. Previously users entered their system name and password, exposing system information to unauthorized users. Now the commands only require the user name and password for the system, protecting system information.

Other enhancements that do not affect generated commands include the ability to view history and log file in Information Steward as well as in the CMC, and the introduction of a new execute command utility named ISTaskExecuteCommand.bat or .sh.
For details about execution commands for using an external scheduler, see the Administrator Guide. See What’s New for more details about the changes in this version.

4.1.2 Metadata Management (14.2.8.2 and 14.2.9.0)

Information Steward 4.2 SP 8 Patch 2 and 4.2 SP9 contains the following behavior changes from the previous version in Metadata Management:

Impact lineage view option for Same As objects

A new Show option for impact and lineage diagrams provides a cross system analysis for Orphan or Same As objects that reside in multiple systems. The new option, Orphan Same As Object, appears under Show in the Settings dialog.

An Orphan or Same As object is an object that exists in different systems.

The Orphan Same As Object option is disabled by default. Therefore, if you want to enable this option after you upgrade to Data Services Version 4.2 SP9, you must change the setting for the Show option so that the Orphan Same As Object option is selected.

To enable the option, follow these steps:
1. In Metadata Management, select an Orphan or Same As object and select to view impact or view lineage.
2. Click the Settings icon in the upper right of the Impact or Lineage tab and select Edit Settings.
3. Select Orphan Same As Object.
4. Click OK.

The impact or lineage diagram includes the Orphan or Same As object when it exists in a different system. For example, the following diagram shows the table “McDonald” in the current system, and in an additional system in which it resides.

For more information about viewing relationships in Metadata Management, see the User Guide.
4.2 Changes in version 4.2 SP4 (14.2.4.0)

The following modules have changes in the Information Steward 4.2 SP4:

- Cleansing Package Builder

4.2.1 Cleansing Package Builder (14.2.4.0)

Upgrade information for Information Steward Cleansing Package Builder.

Turkey added to Person and Firm cleansing package

The Global person and firm cleansing package now includes data to support Turkey person, firm, and date data. You must perform a content upgrade on each applicable cleansing package to include Turkey in your cleansing packages. See Data Cleanse upgrade [page 10] in this guide for information about performing a content upgrade.

Note

See the Data Services Upgrade Guide for information about upgrading to Data Services version 4.2 SP4. Also, Information Steward Cleansing Package Builder has new features for content upgrade. See the Information Steward What’s New document for details.

4.3 Changes in version 4.2 SP3 (14.2.3.0)

The following modules have changes in the Information Steward 4.2 SP3:

- Cleansing Package Builder
- Data Insight
4.3.1 Cleansing Package Builder 4.2 SP3

Upgrade information for Cleansing Package Builder in Information Steward 4.2 SP3.

New ISO2 Country Code column

To support improved international phone parsing features in the Data Cleanse transform in Data Services, there is a new column in the Edit Reference Data tab (data type phone) in advanced mode.

Perform a schema upgrade on the SAP-supplied person and firm cleansing package and on all person and firm cleansing packages that you created using the SAP-supplied cleansing package. Your changes and settings will not change, only the original settings from the original SAP-supplied cleansing package are upgraded. For more information see Data Cleanse upgrade [page 10].

After upgrade, if you add a valid country to the list of countries in the Edit Reference Data tab, you can optionally include the valid ISO2 country code to enable the international phone parsing features in the Data Cleanse transform. If you leave it blank, Data Cleanse parses the phone data on the global level only. For more information see How “Data Cleanse parses phone numbers” in the Designer Guide.

4.3.2 Data Insight 4.2 SP3

Information Steward 4.2 SP3 contains behavior changes from the previous version in Data Insight.

New option to read SAP tables in views

In Information Steward 4.2 SP3, the View Editor of the Data Insight module now provides the Data Transfer Method option through which you can specify ABAP. If you upgrade from Information Steward 4.2 SP2 to 4.2 SP3, views that contain SAP tables will, by default, use the data transport method (RFC, FTP or Shared folder) specified in the connection configuration in the CMC. Edit each view that contains large SAP tables to change the value of Data Transfer Method to ABAP to improve the performance.

Similarly, if you import a view from an older version of Information Steward, you can specify ABAP in the new Data Transfer Method option in the View Editor to improve performance of reading from large SAP tables.

4.4 Changes in version 4.2 SP2 (14.2.2.0)

The following modules have changes in the Information Steward 4.2 SP2 release:

- Cleansing Package Builder
4.4.1 Metapedia 4.2 SP2

Information Steward 4.2 SP2 contains the following behavior changes from the previous version in Metapedia:

**User name**

If a user (not a group) is the author or approver of a term or category, the user name now appears as “Full Name (Account Name)”. In releases prior to 4.2 SP2, only the Account Name appeared.

**Export and import of terms**

When exporting and importing terms and categories, the following behavior occurs in 4.2 SP2:

- The author and approver names are included in the exported Excel file, and import of the file will use those names. In releases prior to 4.2 SP2, the name of the user performing the import became the author even though the author name may have been different in the Excel file.
- If the author name and approver name in the Excel spreadsheet do not exist in the target system with the appropriate right, you can specify a default author name and default approver name.
- For older versions of the exported file that contain the “Approved” column, the values in that column will be ignored.

**Viewing category details**

In 4.2 SP2, you can now view category details such as description and author in the following situations:

- If you have read-only right on Metapedia, you can now double-click a category name in the left pane to view its details.
- When editing a term, you can now view details of a category by clicking its name.

When editing a term, you can now view details of a related term by clicking its name.

For more information, see the Metapedia section in the User Guide:

4.5 Changes in version 4.2 SP1 (14.2.1.0)

The following modules have changes in the Information Steward 4.2 SP1 release:
4.5.1 Data Insight 4.2 SP1

Information Steward 4.2 SP1 contains the following behavior changes from the previous version in Data Insight:

Rule approval process

Approving a rule no longer makes it automatically available to other projects. After a rule is approved, it is private and visible only to the project in which it was created. The rule approver must make it public before it is visible to other projects. Data analysts can then add the public rule to other projects. Similarly, data analysts can remove public rules from their projects.

Address profiling results

After running an address profiling task, you might notice that more addresses are assigned as "correctable". For the address to be considered "valid", the updated version of U.S. address profiling requires the correct data in the address fields including the full 9-digit ZIP+4. Previously, only the 5-digit U.S. ZIP (and correct data in other address fields) was required as a "valid" result.

ABAP program loading for SAP tables in views

Administrators can set up Data Insight views that contain SAP tables to use ABAP programs loaded from an SAP application instead of from Information Steward. Using the SAP application-loaded ABAP programs may improve performance, and is a more secure way to process views in a production environment. See the Administrator Guide and the User Guide for more information about SAP tables and ABAP programs in views.

4.5.2 Metadata Management 4.2 SP1

Information Steward 4.2 SP1 contains the following behavior changes from the previous version in Metadata Management:
Impact and lineage diagrams

In 4.2 SP1, impact and lineage diagrams have been enhanced and are different in multiple ways:

- Dynamically expand or collapse systems and metadata objects to enable you to see only the pertinent objects that you are interested in a large relationship diagram. Instead of right to left, lineage diagrams are now left to right.
- Allow searching and filtering within the relationship diagram to quickly find the pertinent metadata objects.
- Allow searching and highlighting of metadata object to enable you to view a subset of the lineage diagram without losing the context of the found object by not filtering out the adjacent objects.
- Allow you to focus on one metadata object within a relationship diagram and display the impact or lineage of that specific object. Instead of double-clicking an object within a diagram to open its metadata page, you now click the Focus On icon on the pop-up box when you move your cursor over the object.
- Icons in upper left corner now toggles between graphical and tabular view (replaces View pull-down menu).
- Allow tracing a particular impact or lineage path to more clearly see the impact of a particular object on a report or other metadata object.
- Display metadata and all attributes of a metadata object in a pop-up window on the relationship diagram.
- Allow you to go back to a previous or the original lineage diagram after drilling down into specific metadata objects.

For more information, see the following topics in the User Guide:

- Search for objects in impact or lineage diagram
- Dynamic viewing options for impact and lineage diagrams
- More metadata for impact and lineage diagrams

4.6 Changes in version 4.2 (14.2.0.0)

The following modules have changes in the Information Steward 4.2 release:

- Data Insight
- Cleansing Package Builder

4.6.1 Cleansing Package Builder 4.2

This topic contains behavior changes and upgrade information for Cleansing Package Builder in the Information Steward 4.2 release (14.2.0.0).

In this release, there are two upgrade options

- Schema upgrade (required): applies to published and private cleansing packages.
- Content upgrade (optional): applies changes to the Person_Firm cleansing package. Custom cleansing packages cannot be used in the content upgrade process.
Schema upgrade

This required upgrade applies to published cleansing packages. The schema upgrade affects classifications and the underlying structure of the cleansing package necessary for use with the Data Cleanse transform.

**Note**

If you created a category, attribute or classification that has the same name as one of the new categories, attributes or classifications, you should change the name of your conflicting item in the cleansing package, Data Quality Management SDK, and Data Services jobs prior to upgrading, or it will be overwritten during the upgrade process. For example, one of the new categories is named PHONE. See the complete list of reserved words in the *SAP Information Steward User Guide*.

Upgrading the schema does not automatically upgrade the content. Additionally, if you want to upgrade the Person_Firm cleansing packages, see the Content Upgrade section.

To upgrade the published cleansing package schema, open, modify, and then republish the cleansing package. Private cleansing package schemas are automatically updated when they are edited and during merge or content upgrade process.

Content upgrade

This optional upgrade applies only to Person_Firm cleansing packages. The term content refers to the data of the cleansing package: standard forms, variations, reference data, and rules. Content upgrade does not apply to custom cleansing packages or domain-specific cleansing packages, such as person_firm_en. The following content changes are available in the 4.2 release. When upgrading the content, all of these features are upgraded.

**Table 7:**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pattern classification</td>
<td>The pattern classification for Name_Patronymic_Pattern is updated.</td>
</tr>
<tr>
<td>Phone</td>
<td>The regular expressions are updated.</td>
</tr>
<tr>
<td>Standard forms/Variations</td>
<td>Several primary and secondary entries for standard forms and variations are updated to include the Firm_Match_Remove classification. During upgrade, if an existing entry is found that the user has modified, the upgrade retains the user-modified standard form or variation. No changes are applied to that entry. If an existing entry is found that has not been modified, the entry is upgraded. If an entry is not found, the new entry is added.</td>
</tr>
<tr>
<td>Data Cleanse dictionary</td>
<td>The version number is updated.</td>
</tr>
</tbody>
</table>

To upgrade the content of a Person_Firm cleansing package:

1. From the Cleansing Package Builder tab, click More ➤ Content Upgrade ➤.
2. Select the cleansing package, and then click OK.

The cleansing package is updated. Click Close on the Content Upgrade Results window.
Change to user-defined pattern matching

If you created definitions specific to a particular input field, you might see a behavior change where all definitions are applied to all input fields that have a user-defined definition. For example if the input field Multiline1=Definition1 and Multiline2=Definition2, the following occurs.

Table 8:

<table>
<thead>
<tr>
<th>Release version</th>
<th>Input field definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.1</td>
<td>Multiline1=Definition1</td>
</tr>
<tr>
<td></td>
<td>Multiline2=Definition2</td>
</tr>
<tr>
<td>4.2</td>
<td>Multiline1=Definition1, Definition2</td>
</tr>
<tr>
<td></td>
<td>Multiline2=Definition1, Definition2</td>
</tr>
</tbody>
</table>

Cleansing package installation

The cleansing package is now installed with Information Steward. In the Select Features window under Information Steward Services, make sure that the Cleansing Package option is selected so that the cleansing package is installed. Without the cleansing package, you will not be able to run Data Cleansing Advisor.

4.6.2 Connection changes in 4.2

In Information Steward version 4.2, you now have the capability to define server name (also known as DSN-less and TNS-less) connections to a profiling source or database to store data that failed validation rules. The following table lists the 4.1.1 parameters and the 4.2 parameters to connect to each database type.

Table 9: Connection parameters to profiling source and to data that failed validation rules

<table>
<thead>
<tr>
<th>Database Type</th>
<th>4.1 Connection Parameters</th>
<th>4.2 Connection Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM DB2</td>
<td>Data Source Name</td>
<td>When Use Data Source Name (DSN) is set to No:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Server Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Database Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Port Number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When Use Data Source Name (DSN) is set to Yes:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Data Source Name</td>
</tr>
<tr>
<td>Database Type</td>
<td>4.1 Connection Parameters</td>
<td>4.2 Connection Parameters</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------</td>
<td>---------------------------</td>
</tr>
</tbody>
</table>
| SAP HANA      | Data Source Name          | When *Use Data Source Name (DSN)* is set to No:  
|               |                           | • Server Name              |
|               |                           | • Port Number              |
|               |                           | When *Use Data Source Name (DSN)* is set to Yes:  
|               |                           | • Data Source Name         |
| Informix IDS  | Data Source Name          | When *Use Data Source Name (DSN)* is set to No:  
|               |                           | • Server Name              |
|               |                           | • Database Name            |
|               |                           | • Port Number              |
|               |                           | When *Use Data Source Name (DSN)* is set to Yes:  
|               |                           | • Data Source Name         |
| MySQL         | Data Source Name          | When *Use Data Source Name (DSN)* is set to No:  
|               |                           | • Server Name              |
|               |                           | • Database Name            |
|               |                           | • Port Number              |
|               |                           | When *Use Data Source Name (DSN)* is set to Yes:  
|               |                           | • Data Source Name         |
| Netezza       | Data Source Name          | When *Use Data Source Name (DSN)* is set to No:  
|               |                           | • Server Name              |
|               |                           | • Database Name            |
|               |                           | • Port Number              |
|               |                           | When *Use Data Source Name (DSN)* is set to Yes:  
|               |                           | • Data Source Name         |
| Oracle        | Database Connection Name  | When *Use TNS Name* is set to No:  
|               |                           | • Server Name              |
|               |                           | • Instance Name            |
|               |                           | • Port Number              |
|               |                           | When *Use TNS Name* is set to Yes:  
<p>|               |                           | • Database Connection Name |</p>
<table>
<thead>
<tr>
<th>Database Type</th>
<th>4.1 Connection Parameters</th>
<th>4.2 Connection Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sybase IQ</td>
<td>Data Source Name</td>
<td>When Use Data Source Name (DSN) is set to No:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Host Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Database Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Port Number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Server Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When Use Data Source Name (DSN) is set to Yes:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Data Source Name</td>
</tr>
<tr>
<td>Teradata</td>
<td>Data Source Name</td>
<td>When Use Data Source Name (DSN) is set to No:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Server Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Database Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Port Number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When Use Data Source Name (DSN) is set to Yes:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Data Source Name</td>
</tr>
</tbody>
</table>

### 4.6.3 Match Review changes in 4.2

Information Steward 4.2 contains the following behavior changes from the previous version:

- After a Match Review configuration has been created, you can no longer change its name.
- You can now add or delete display columns in a match review configuration when the match review task has the status **In Progress**. However, if best record creation is enabled and the match review task has the status **In Progress**, you cannot add or delete display columns.
- A new match review activity table exists to record the match review results, which includes whether a record was changed from **Match** to **Unmatch**, or from **Unmatch** to **Match**, or if a record was moved from or into a different match group. For more information, refer to “Match review activity table” in the User Guide.
- The **Match Review Result** column is no longer required in the input table and is not displayed in the match review user interface because it is replaced with the more extensive match review activity table.
- For best record creation, the datetime data type will be treated the same as the date data type. The Match Review user interface shows the original datetime values, but the time portion will be stripped off when the match review is saved.

### 4.6.4 Data Insight changes in 4.2

Information Steward 4.2 contains the following behavior changes in Data Insight from the previous version:

- When displaying profile results for data from SAP HANA databases, the basic attributes start appearing before word or pattern distribution, and a timestamp appears for when profile results were generated.
4.7 Changes in version 4.1 SP1 (14.1.1.0)

The following modules have changes in the Information Steward 4.1 SP1 release:

- Data Insight
- Metadata Management
- Metapedia

4.7.1 Data Insight 4.1 SP1

This topic contains behavior changes and upgrade information (if applicable) for Data Insight in the Information Steward 4.1 SP1 release (14.1.1.0). To obtain these new features, run the installation program on the computer that has your current version of the software installed. The repository does not need to be upgraded in order for you to access these new features.

Data Insight join ranking feature

After you upgrade to Version 4.1 SP1, open a view that contains joins, or create a new view with multiple tables and then create joins. Click the new button in the Join Conditions tab named Set Optimal Order to open the Set Optimal Order dialog. There you can rank the joins in any order. The software processes the joins in the order you set.

The join ranking feature is automatically added to the Data Insight module when you create a new view or edit an existing view.

For more information see the User Guide.

Connections in views

When you import views, Information Steward no longer overwrites existing connections and you no longer have the option Overwrite existing connections used in imported views.

You can now specify target connections and schemas if they differ from the imported ones. However, the target connection must already be defined on the Information Steward system to which you are importing the view.

Profile and rule task names

When you define a profile task or rule task, the application no longer assigns a name. You can now enter a user-defined name, which can be more descriptive. This update makes finding a specific task in the Tasks tab of Data Insight easier.
4.7.2 Metadata Management 4.1 SP1

This topic contains behavior changes and upgrade information (if applicable) for Metadata Management in the Information Steward 4.1 SP1 release (14.1.1.0).

New Crystal Report attributes

Crystal Reports now include new attributes when you view a Crystal Report instance:

- Report Fields
- Formula Fields
- SQL expression Fields
- Running Total Fields

To upgrade Information Steward so that the new Crystal Report fields are available in Metadata Management, follow the steps in Upgrading to the new Crystal Report attributes [page 30] in this guide.

Deprecated runtime parameters

In SAP Metadata Management version 3.x (12.x), the following optional run-time parameters for the BusinessObjects Enterprise Metadata Integrator were provided to collect user permissions. In Information Steward 4.x, these parameters have been removed:

- ppc
- pplimit

4.7.2.1 Upgrading to the new Crystal Report attributes

Upgrade your current installation of SAP Information Steward to version 4.1 support pack 1. Then schedule each applicable integrator in the Central Management Console (CMC) using Delete existing objects before starting object collection.

To upgrade Information Steward so that the new Crystal Report fields are available in Metadata Management:

1. Log on to the CMC and go to the Information Steward area.
2. Select Metadata Management ➤ Integrator Sources from the file tree in the left pane. All of your integrators are listed in the main pane on the right.
3. Right-click on the applicable SAP Enterprise integrator and select Schedule ➤ Parameters from the drop list.
4. Select all of the applicable Collect check boxes and other parameters as necessary.
5. In Update Options select the Delete existing objects before starting object collection check box.

You could choose Update existing objects and add newly selected objects. However, if you want to view the Crystal Report fields, you should select the option Delete existing objects before starting object collection. If
you choose **Update existing objects and add newly selected objects**, you must modify the applicable reports after you have completed the integrator upgrade before any new report fields are collected.

6. Click **Schedule**.
   Repeat the steps above for each applicable integrator source.

When you open the newly upgraded Information Steward software, the following new attributes appear (when applicable) in a Crystal Report instance if you upgraded the integrator sources using the **Delete existing objects before starting object collection** option:

- Report Fields
- Formula Fields
- SQL expression Fields
- Running Total Fields

For more information about these steps and about administrative tasks in the CMC, see the *SAP Information Steward Administrator Guide* or the Information Steward section of the *SAP Data Services and SAP Information Steward Master Guide*.

**4.7.3 Metapedia 4.1 SP1**

This topic contains behavior changes and upgrade information (if applicable) for Metapedia in the Information Steward 4.1 SP1 release (14.1.1.0).

**Term approval process**

There is a new term approval process for Metapedia. The process requires the following new user groups: Metapedia Author, Metapedia Approver, and Metapedia Administrator. The author creates and defines the term and sends it to the approver who reviews and approves or rejects the term. The administrator sets up the users and groups with rights and permissions. The administrator can also reassign terms to other users or groups.

The Metadata Management Data Steward user group has the same rights as the Metapedia Author and Approver.

There is some important information for the next time you upgrade Information Steward:

- The **MMT_Business_Term** table is updated during the upgrade process as follows:

<table>
<thead>
<tr>
<th>Column</th>
<th>Default value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>last_submitted_by</td>
<td>NULL</td>
<td></td>
</tr>
<tr>
<td>time_version</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>term_state</td>
<td>E</td>
<td>E=editing</td>
</tr>
</tbody>
</table>
  |                  |               | If the value of the is_approved column is Y (yes), then the term_state column contains A (approved) only for the current version of the term.
<table>
<thead>
<tr>
<th>Column</th>
<th>Default value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>term_approver</td>
<td>NULL</td>
<td>If the term was approved previously, this value shows the user in the create_actor_id column who approved the term.</td>
</tr>
</tbody>
</table>

- When the upgrade is complete, if the author is not assigned, then any user with rights to manage terms can assign himself as the author. The user should then select an approver.
- Any terms in the editing or approved states before the upgrade will continue to be in those states after upgrading.
- Any terms in submitted or rejected states prior to upgrade will be set to an editing state after upgrade.

### 4.8 Changes in version 4.1 (14.1.0.0)

The following modules have changes in the Information Steward 4.1 release:

- Metadata Management
- Metapedia
- Cleansing Package Builder

Also, there are several changes in the UI that we have listed in a table

#### 4.8.1 Changes in locations for user interface options

In version 4.1 of SAP Information Steward, the locations of the following user interface options and buttons have changed.

<table>
<thead>
<tr>
<th>User Interface Option or Button</th>
<th>Location in 4.0</th>
<th>Location in 4.1</th>
</tr>
</thead>
<tbody>
<tr>
<td>About</td>
<td>Upper right corner of Information Steward user interface</td>
<td>Select from Help drop-down menu on upper right corner of Information Steward user interface</td>
</tr>
<tr>
<td>Custom Attributes</td>
<td>Select from Open drop-down menu on upper right corner of Metadata Management tab</td>
<td>Select from Manage drop-down menu on upper right corner of Information Steward user interface</td>
</tr>
<tr>
<td>Finding Metapedia terms</td>
<td>Filter terms on top middle of main Metapedia pane</td>
<td>Search on top far right of main Metapedia pane</td>
</tr>
<tr>
<td>Export List</td>
<td>Select from Open drop-down menu on upper right corner of Metadata Management tab</td>
<td>Upper right corner of Metadata Management tab</td>
</tr>
<tr>
<td>Export Views</td>
<td>On Workspace Home of Data Insight tab, select from Manage Views drop-down menu</td>
<td>While on Workspace Home, on upper right corner of Data Insight tab, click the Export icon (️) and select Tables from the drop-down menu</td>
</tr>
<tr>
<td>User Interface Option or Button</td>
<td>Location in 4.0</td>
<td>Location in 4.1</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Import Views</td>
<td>On Workspace Home of Data Insight tab, select from Manage Views drop-down menu</td>
<td>On upper right corner of Data Insight tab, click the Import icon ( ) and select Tables from the drop-down menu</td>
</tr>
</tbody>
</table>
| Export Rules                  | On Rules tab of Data Insight tab, click Export To and select one of the following options:  
  - File  
  - Data Services | While on Rules tab, in the upper right corner of Data Insight tab, click the Export icon ( ) and select one of the following options:  
  - Project  
  - Rules to File  
  - Rules to Data Services |
| Import Rules                  | On Rules tab of Data Insight tab, click Import | While on Rules tab, in the upper right corner of Data Insight tab, click the Import icon ( ). |
| Export File Formats           | On File Formats tab of Data Insight tab, click Export | While on File Formats tab, in the upper right corner of Data Insight tab, click the Export icon ( ). |
| Import File Formats           | On File Formats tab of Data Insight tab, click Import | While on File Formats tab, in the upper right corner of Data Insight tab, click the Import icon ( ). |
| Object Tray                   | Upper right corner of Information Steward user interface | Upper right corner of Metadata Management tab |
| Preferences                   | Select from Open drop-down menu on upper right corner of Metadata Management tab | Select from Manage drop-down menu on upper right corner of Information Steward user interface |
| Reports                       | Select from Open drop-down menu on upper right corner of Metadata Management tab | Select from View drop-down menu on upper right corner of Information Steward user interface |
| Search preference             | In the Information Steward user interface, select Open Preferences and under Search Preferences is option Delay time before changes in Information Steward affects the search results (seconds) | In the Central Management Console, go to the Applications area, right-click Information Steward Application and select Configure Application, scroll down and under Search Preferences is option Update time (seconds) |

### 4.8.2 Metadata Management 4.1

This topic contains behavior changes and upgrade information (if applicable) for Metadata Management in the Information Steward 4.1 release (14.1.0.0).
SAP NetWeaver BW Metadata Integrator upgrade

When you upgrade from an older version of Information Steward to version 4.1, schema changes are made to the SAP NetWeaver Business Warehouse Metadata Integrator. Because of these changes, the previously collected metadata objects are not displayed until the metadata integrator is run again. This scenario is shown in the following ways:

- In the Metadata Management directory page, the objects for the metadata integrator do not display. Instead, there is a message that states: "Run required: Ask your Information Steward administrator to run the integrator source in the CMC".
- In the integrator sources list in the Central Management Console (CMC) for Information Steward, the Last run column displays Run required for upgrade.

To collect the metadata and view the metadata objects in Information Steward, run the Metadata Integrator immediately or wait for the next scheduled run.

Deprecated runtime parameters

In SAP Metadata Management version 3.x (12.x), the following optional run-time parameters for the BusinessObjects Enterprise Metadata Integrator were provided to collect user permissions. In Information Steward 4.x, these parameters have been removed:

- ppc
- pplimit

4.8.3 Metapedia 4.1

This topic contains behavior changes and upgrade information (if applicable) for Metapedia in the Information Steward 4.1 release (14.1.0.0).

In the Metapedia module of Information Steward version 4.1, the user interface has several changes and enhancements. For more information, see the “Metapedia” section in the What’s New Guide and in the User Guide. Specific behavior changes in version 4.1 of Metapedia include the following:

- The name of a Metapedia term must not contain a comma (,). In version 4.0, commas were allowed.
- You can now add an unapproved term to a category.
- The filter feature has changed to a search box and Advanced Search, similar to that in Metadata Management.

4.8.4 Cleansing Package Builder 4.1

This topic contains behavior changes and upgrade information (if applicable) for Cleansing Package Builder in the Information Steward 4.1 release (14.1.0.0).
Global SAP-supplied person and firm cleansing package

SAP has created a global SAP-supplied person and firm cleansing package which consolidates the variations that previously existed in more than 20 individual regional person and firm cleansing packages. Each variation is assigned to the Global domain and to additional domains when cultural standards vary by locale or region.

Script classifications

Changes have been made in the way scripts are classified. The Latin_Script and Kanji_Script classifications are obsolete, but will still be recognized by Data Cleanse. It is recommended that you discontinue use of these obsolete classifications and replace classifications as shown in the following table:

Table 12:

<table>
<thead>
<tr>
<th>Script</th>
<th>4.0 Classification</th>
<th>4.1 Classification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hiragana</td>
<td>Kana_Script</td>
<td>Kana_Script</td>
</tr>
<tr>
<td>Katakana</td>
<td>Kana_Script</td>
<td>Kana_Script</td>
</tr>
<tr>
<td>CJK</td>
<td>Kanji_Script</td>
<td>CJK_Script</td>
</tr>
<tr>
<td>Hangul</td>
<td>Kanji_Script</td>
<td>Hangul_Script</td>
</tr>
<tr>
<td>Thai</td>
<td>Latin_Script</td>
<td>Thai_Script</td>
</tr>
<tr>
<td>All other scripts</td>
<td>Latin_Script</td>
<td>Other_Script</td>
</tr>
</tbody>
</table>

Parsing data

The option to parse data based on whitespace and transitions between letters, numbers, or special characters now also breaks data when there is a change in script type. Five script types are identified: CJK, Kana, Hangul, Thai, and Other. The Other_Script type includes all scripts except the four specifically named. Examples of other scripts are Latin, Cyrillic, Greek, Hebrew, and Vietnamese.

In addition to word-breaking based on the previously identified criteria, CJK, Kana, Hangul, and Thai scripts break after each character.

Deprecated and changed options

Cleansing Package Builder now automatically detects Japanese data. In the cleansing package creation wizards, you no longer need to specify if you have Japanese data and if you want to normalize that data.

The following changes have been made in the ATL file that Cleansing Package Builder creates:

- Japanese engine option was removed
- Cleansing Package changed to Cleansing Package Name
- Content Domain Sequence option added
Social Security Number file

The U.S. Social Security Administration is no longer updating its Social Security Number algorithm. Thus SAP no longer provides an updated DRLSSN.dat file. The file dated July 5, 2011 is the final file that SAP will provide.

For more information about the Social Security Administration’s new assignment process, see http://www.ssa.gov/employer/randomizationfaqs.html.

Merge the global domain

When you upgrade from a previous version of Information Steward to version 4.1, be aware of how you select the global domain. The global domain is the default setting in Data Services Data Cleanse transforms, so if you overwrite the default variations, you may receive unexpected results when you run a Data Cleanse job.

Related Information

Merging custom changes into a global cleansing package [page 36]
Merging custom Chinese, Japanese, or Korean changes into a global cleansing package [page 37]
Merging and the global domain [page 37]

4.8.4.1 Merging custom changes into a global cleansing package

Before merging to a global cleansing package:

- Create a private target cleansing package based on the SAP-supplied global cleansing package.
- Create a backup of your target cleansing package.
- Publish all private cleansing packages that you want to merge. Otherwise, if you have unpublished changes to the linked private cleansing package, those changes will not merge with the new cleansing package.
- Note that any user-defined rules will not be merged with the global cleansing package. We recommend that you publish and test the cleansing package, and then modify the rules as necessary.

To merge a version 4.0 cleansing package into a global SAP-supplied cleansing package:

1. From the Cleansing Package Tasks window, choose More Merge Changes.
2. In the Merge source section, select a published SAP-supplied person and firm cleansing package that was for a specific locale in version 4.0.
3. In the Merge target section, select a private global cleansing package from the list.
4. The domain option is updated based on the source cleansing package. If it is incorrect, choose the correct
domain from the list, and then click OK.
The Merge Changes Results window shows whether the merge was successful as well as warning and error
information. Click Close.

When you have multiple cleansing packages that use different locales, and you want them all merged into one
target, repeat these steps for each cleansing package and choose the same target for all cleansing packages. You
may want to merge the cleansing package with the most changes first, and then end with the merge of the
cleansing package with the least changes.

i Note
If you receive errors during the merge, the target cleansing package remains unchanged. If you receive
warnings, the target cleansing package is updated.

Related Information

Merging custom Chinese, Japanese, or Korean changes into a global cleansing package [page 37]
Merging and the global domain [page 37]

4.8.4.2 Merging custom Chinese, Japanese, or Korean changes into a global cleansing package

If you have a previous version of a Chinese, Japanese, or Korean cleansing package, first try using the new SAP-
supplied global cleansing package in your Data Services Data Cleanse job. You may find that the updated rules
produce similar enough results so that you need to make only minor modifications in the 4.1 version.

If the results are not what you expect, refer to the section “Region-Specific data” in the Information Steward User
Guide. There you will find several examples for adding family names, given names, titles, and other name-related
information.

Related Information

Merging custom changes into a global cleansing package [page 36]
Merging and the global domain [page 37]

4.8.4.3 Merging and the global domain

Be careful about selecting the global domain when you merge from previous versions of the software to the most
current version. The global domain is the default setting in Data Services Data Cleanse transforms, so if you
overwrite the default variations, you may receive unexpected results when you run a Data Cleanse job.
Example

Same variation contains different settings

What happens when the same variation has different classifications, gender, standard forms and/or aliases?

Let’s say that you have two locale-specific cleansing packages in a previous version of Cleansing Package Builder: Person_Firm_EN and Person_Firm_FR. You want to add your modifications to the single, global cleansing package named Global_Person_Firm.

The Merge Changes utility reviews all of the data and compares it to the default (global) settings. If it finds a variation that is exactly the same as the default, then a domain-specific variation will not be added. However, if the variation is different than the default, a new variation is added under the domain setting you specify. See the data in the following example.

<table>
<thead>
<tr>
<th>Variation</th>
<th>Classification</th>
<th>Gender</th>
</tr>
</thead>
<tbody>
<tr>
<td>John</td>
<td>Firm_Name</td>
<td>Strong_Male</td>
</tr>
<tr>
<td>Jean</td>
<td>Name_Strong_Given_Name</td>
<td>Weak_Female</td>
</tr>
</tbody>
</table>

In the Merge Changes window, the selected domain is English (United States & Canada). The previous version cleansing package (source) is compared with the current version cleansing package (target). The source cleansing package has the variation John, which is exactly the same as in the target. Therefore, the EN_US domain variation is not added. However, Jean has a different classification and gender. Therefore, an EN_US variation is added to the cleansing package.

After successfully merging the Person_Firm_EN cleansing package, select the Person_Firm_FR cleansing package and select the French domain. Then the French source is compared to the global target with the following results.

<table>
<thead>
<tr>
<th>Variation</th>
<th>Classification</th>
<th>Gender</th>
</tr>
</thead>
<tbody>
<tr>
<td>John</td>
<td>Firm_Name</td>
<td>Strong_Male</td>
</tr>
<tr>
<td>Jean</td>
<td>Name_Strong_Given_Name</td>
<td>Strong_Male</td>
</tr>
</tbody>
</table>

Note that if the variation Jean was exactly the same in the EN_US domain, Jean is also added in the FR domain. If you find that your variations are the same across all locale-specific sources, you may want to merge to the
global domain first. This means that the variations in the source overwrite the global domain. The following is an example of selecting `global` as the domain on the `Merge Changes` window.

After merging and selecting the global domain, the target variations would look as follows, with the classification and gender changing for the variation Jean.

Use caution when overwriting the global domain. Remember that the Data Services Data Cleanse transform uses the global domain by default. Therefore, if you overwrite the global domain, you may receive some unexpected results. If you are merging multiple sources into one target, then the last source that is merged determines what the global definition is. For example, if you overwrite the global domain with the EN_US domain of Jean, and then overwrite global with the FR domain, the variation Jean is output with a gender of `Strong_Male`.

**Example**

**Variation deleted from source**

What happens when a variation has been deleted from the source?

If you have deleted a variation from the source, then the variation will be deleted from the target depending on the domain you choose on the `Merge Changes` window. If the target already has an EN_US variation of Jean, and you select `English (United States & Canada)`, then Jean is deleted only from the EN_US domain in the target.
However, if you have the variation Jean deleted from the source and select Global domain on the Merge Changes window, then the variation is deleted from all domains in the target.

Related Information

Merging custom changes into a global cleansing package [page 36]
Merging custom Chinese, Japanese, or Korean changes into a global cleansing package [page 37]
5 SAP information resources

A global network of SAP technology experts provides customer support, education, and consulting to ensure maximum information management benefit to your business.

Useful addresses at a glance:

Table 13:

<table>
<thead>
<tr>
<th>Address</th>
<th>Content</th>
</tr>
</thead>
</table>
| Customer Support, Consulting, and Education services  
http://service.sap.com/   | Information about SAP Business User Support programs, as well as links to technical articles, downloads, and online discussions.                                                                 |
| Product documentation  
| Supported platforms (Product Availability Matrix)  
https://service.sap.com/PAM | Information about supported platforms for SAP Information Steward with a search function to quickly find information related to your platform.                                                        |
| Product tutorials  
http://scn.sap.com/docs/DOC-8751 | Tutorials that have been developed to help you find answers to the most common questions about using SAP Information Steward.                                                                                |
| Forums on SCN (SAP Community Network)  
https://go.sap.com/community/topic/information-steward.html | Discussions that include information and comments from other SAP users and the means to share your knowledge with the community.                                                                       |
| EIM Wiki page on SCN  
https://wiki.scn.sap.com/wiki/display/EIM/Enterprise+Information+Management++EIM | The means with which to contribute content, post comments, and organize information in a hierarchical manner so that information is easy to find.                                                 |
Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are not intended to be used in a productive system environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP intentionally or by SAP's gross negligence.

Accessibility

The information contained in the SAP documentation represents SAP's current view of accessibility criteria as of the date of publication; it is in no way intended to be a binding guideline on how to ensure accessibility of software products. SAP in particular disclaims any liability in relation to this document. This disclaimer, however, does not apply in cases of willful misconduct or gross negligence of SAP. Furthermore, this document does not result in any direct or indirect contractual obligations of SAP.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with "you", or a gender-neutral noun (such as "sales person" or "working days") is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages caused by the use of related information unless damages have been caused by SAP's gross negligence or willful misconduct. All links are categorized for transparency (see: http://help.sap.com/disclaimer).